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1. Technical requirements

Microsoft Dynamics 365 Business Central

2. Starting the VPS: Info window shows progress when
loading/reloading

When data is loaded into the VPS, multiple stages of data processing are executed until the
visualization finally appears and the user can start working with it. Especially when there are large
amounts of data to be loaded/reloaded, this can take some time during which the users do not know
what is happening and are often unsure whether the application is still working.

To give the users detailed feedback as to what is happening during the loading process, we have
implemented an info window that:

e gives feedback that something is happening at all (meaning the extension has not crashed)

e informs about the amount of data getting loaded, thus explaining why the process might
take so long

e informs about how long this process might take and how long the users might need to wait

e also helps our support team during customer trainings or support cases to get a better
understanding of the customers' environment.

Large Data Set - Production | NETRONICVAPS.-  NETRONICVPS-  NETRONIC VIS =

Visual Production Scheduler: ~ All -~ NETRONIC VPS ~  £&| Open in Excel More options o]

January 2021

Production Order Wk 03

Working on it...

21 22

Processing Activity: 1/4 Reading data from Business Central
Work Center Group: 2 of 2

Work Center: 5

Machine Center: 14

Calendar Entry: 2620

Production Order: 25 of 122

Production Order Line: 26

Prod. Order Routing Line: 128

Prod. Order Capacity Need: 289

Cancel
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3. Understanding the VPS

Depending on the editing mode you are working in — Scheduler or Viewer — the elements and options
shown and offered may differ. For detailed information about the differences between the two
modes see chapter Viewer Mode vs Scheduler Mode

Since the VPS is a Gantt chart, it naturally has all its characteristics:

) Jan 25, 2021 Jan 26, 2021 Jan 27, 2021 Jan 28, 2021 Jan 29, 2021 Jan 30, 2021 Jan 31, 2021
Production Orders
12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM(| 12:00 PM

} 109001 (Bicycle) ™ ¢
4 Firm Planned
4 1010005 (Bicycle) L4 | ¢
4 10000 4 . [ ]
10 (Wheel assembly)
20 (Chain assembly)
30 (Final assembly)
40 (Control) ﬂ
} 1011002 (Bicycle) 4 \ ¢

e Atimescale at the top.

e Atable at the left, production orders (in the Production Order View) or work and machine
centers in the Resource View

e On the right below the time scale, a chart displaying the production schedule with a calendar in
the background indicating work free periods in grey while working times appear in white.

e A menu ribbon allowing to make basic settings that will be explained in detail in the following.

Visual Production Scheduler:  All »~ | NETRONIC VPS ~ Open in Excel | Actions~  Fewer options

The item “NETRONIC VPS” summarizes the options that we think are the most frequently used
ones:

NETRONIC VP5~  Page ~

BE Reload
H save
Capacity View
B8 Production Order View

F.1 Setup

All options of the VPS can be found under “Actions”:
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Actions~  Fewer options

| General b
View Filter >
Calendar 2
Timescale S

Capacity Aggregation >
View >

Administration > T

In case the “Actions” item is not visible in the menu ribbon, click “More options”. To hide it again,
click “Fewer options”.

e Avertical line in the chart indicates the work date as having been set in Dynamics 365 Business
Central.

Wk 15
06 |07 |08 |09 10

|

e A blue dashed line indicates the time when your plan was last updated.

e Aninteractive status bar:
In the world of visual scheduling, it's easy for planners to get lost in a sea of data and wonder
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why they're seeing certain information. The status bar below the Gantt chart ensures that
planners always know what they're looking at and provides real-time information about:

o The current editing mode.

o The active view filters, or whether no filter is active.
o The active color mode.

» 101058 (Prod 11 - type 1)

» 101059 (Prod 12 - type 7a) Lo

» 101062 (Prod 13 - type 2¢)

 e— >« — )

Editing Mode: Scheduling Active view fitter: No view filter active Active color mode: Production Order Status View

By clicking on the respective entry, the corresponding selection option is offered, which saves
you having to go through the menu.

- 1w v ~ v

10 (LC 500)

20 (Wagner B 24
(Fprais) B @ Changing Editing Mode from Scheduling to Viewing Only?

4 101056 (Comp 1 - Prod 000009 - t;

» 10000

4 101057 (Prod 10 - type 1c) p

P e — IS
10 (Wagner BAZ) m

20 (CTX400) 20

30 (Assembly - Team 1) 30

40 (Quality Control) o0 |
P 101058 (Prod 11 - type 1) — 'Y

» 101059 (Prod 12 - type 73) P | ¢

» 101062 (Prod 13 - type 20)

Ediling Mode: Scheduling Active view fililer: No view filter active Active color mede: Production Order Status View

In the "Appearance Section" of the VPS Setup dialog, you can specify whether to show/hide
the status bar.

Hide Status Bar D
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4. Viewer Mode vs Scheduler Mode

In the earlier days when Business Central was known as Dynamics NAV, we offered a VPS planner
license and a VPS viewer license. With the transition to Business Central, we just had one VPS license,
enabling widespread access for schedule adjustments. If customers wanted only certain people to be
able to make changes, we basically left it up to them to ensure this through appropriate processes
and training.

Over time, spurred by customers' feedback and evolving needs, we recognized scenarios where a
visual production schedule in a view-only mode could be invaluable. This led to the development of
the VPS Viewer Mode.

4.1. Why and how: VPS Viewer Mode

There are use cases, where “non-production-scheduling-people” want to see the production
schedule. Examples:

e Sales
o What: check and understand the general production backlog
o Why: derive conclusions for delivery time commitments

e Shopfloor workers
o What: see which production orders are scheduled for today
o Why: make operational decisions (if allowed)

We built the VPS Viewer Mode with all cases in mind but focused on the shopfloor

e Sales = open schedule, assess backlog, make conclusion, close schedule
e Shopfloor = schedule “always on” ... on a screen on the floor

o Needs to show a fixed period

o Needs to be pre-filtered

o Needs to update automatically

In the Viewer Mode, all options for changing the schedule are deactivated and the corresponding
menus and functionalities — also for saving - are hidden. However, changes to Business Central data
are still possible via the Business Central pages!

As usual, the progress window is displayed during reloading. If the user was previously working as a
planner, changed data there, and then switched to the viewer mode, the changed data will be
overwritten without prompting (saving is not provided in the viewer mode).
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Visual Production Scheduler:  All ~ NETRONIC VPS ~ Actions ~  Fewer options

. BB Reload Thursday, 01. February 2024
Production Orders
N 6:f 3 : A 14:00 | 16:00 (18:00 | 20:00 | 22:00 :
@ Capacity View

10 (CTX400) gap ar Vie

20 (LC 500) h Histogram View

30 (Saw | S&ge) _E'SE‘“ID

40 (Wagner BAZ) 40 Navigstion R

50 (Assembly - Team 1) Sort Order | 50

Show Additional Information» |
60 (Quality Control)

4 101005 (Prod 1 - Type 7)

4 10000
10 (CTX 2500)
20(LC 180)

30 (Saw | Sage) 30

AR FTE 390 Benthan an

4.2. How to switch between Viewer Mode and Scheduling Mode

The mode can be selected by the according option in the “Editing Mode” area in the VPS setup. The
Scheduling Mode is preset as default.

Editing Mode

Editing Mode |V\ewmg only . ‘

Scheduling
Timeframe Type

Depending on the selected mode, the settings offered in the newly added “Automatic Screen
Updates” area of the Setup dialog differ:

Viewer mode:

e whether and how often the view should be updated
e whether and how often the view should scroll
o whether the current date-timeline is shown and how often it should be updated

Automatic Screen Updates

Reload of Data Horizontal Scrolling of Diagram

Enable Automatic Reload of Data [ o] Enable Horizontal Aute Scrolling of Diagram - - (D

Set Interval of Automatic Reload of Data in ... 1 | Set Interval of Horizontal Auto Scrolling of ... ‘ 1

Current Date-Time Line

Show Current Date-Time Line [ o]
Set Interval of Current Date-Time Line in Se.. ‘

Scheduler mode

e whether the current date-timeline is shown and how often it should be updated
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5. Three different views and their options

There are three different views in the VPS: The Production Order View, the Capacity View, and the
Histogram View. You can switch between them by using the corresponding menu items:

Actions Fewer options
General b
View Filter b
Calendar >

Timescale >

Capacity Aggregation >

View > Capacity View i

]

Administration » B8 praduction Order View

il Histogram View

5.1. Two color modes

The VPS offers two different color modes to stress certain aspects of your plan with predefined
colors for the bars. They can be applied in the Production Order View and in the Capacity View.

On the “Color Mode Setup” page, accessible from the Role Center via “Color Mode Setup”, users can
freely define colors for both “Production Order Status” and “Execution Status”.

VAPS - Gi Production Orders Sales & Purchases~  Journals Worksheets Product Design
Visual Production Scheduler @
| & vPs Color Mode Satup 3 + Ty Saved [N =
- VAPS - Gi
Actions
Production Order Status
Planned Production O... #66ccff - Released Order

Firm Planned Order

Execution Status

Ready to get in Progr.. | #00ee00 Rest of Operations #0008 -
In Progress Operations | #999999 Operation with Postin.. | #E7ACAC -

S *
& &
e

i o'
H a
H a

Finished Operations
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You can switch between the two modes by

e Selecting the view via "Actions" menu:

NETROMIC VPS ~~ | Actions ~  Fewer options

bruary 2024 ) ]
g "r View Filter >
k| wk 08
1819 |20 |2 Search S
Calendar >

Timescale > —
Capacity Aggregation » -

View Color Mode > 88 Production Order Status View _

lef] Execution Status View

e C(Clicking on the entry in the status bar:

Changing Color Schéme Mode from Production Order Status
Rl @ e
Lo
i e
_. —
n oy |
!
"o |
i
—— ’ i

5.1.1. Production Order Status View Color Mode

The Production Order Status View is the default color mode of the VPS and helps you to quickly see
where in your scheduling & execution process your production orders are. It differentiates
production orders by their respective status and indicates this by different colors for the following
statuses. The picture below shows the default colors:

p Planned

p Firm Planned

Please note that the VPS will always start in the Production Order Status View.
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5.1.2. Execution Status View Color Mode

With this mode, you get feedback on the operations' status on the shop floor: ready to get in
progress, in progress, finished, with posting issues, and the rest. The colors listed below are defined
as default:

Color Default Color Code | Color Setup Name
#30=2200 Ready to get in Progress Operation
#9099009 In Progress Operation
#eeeeee Finished Cperation
#B8a8fF Rest of Operation
#ad7d31 Operation with Posting Issue

5.2. The Production Order View

Mg, Jan 25, 2021 Tu, Jan 26, 2021 We, Jan 27, 2021 Th, Jan 28, 2021 Fr, Jan 29, 2021

Production Orders

06:05 A 12:00 PM 12:00 AM 12:00 AM 12:00 AM
4 109001 (Bicycle) ==
» 10000 =
4 Firm Planned EI
» 1010005 (Bicycle) 4 .
4 1011002 (Bicycle) v 1
4 10000 4 b
10 (Wheel assembly) :
20 (Chain assembly)
30 (Final assembly)
40 (Control) 40 |
» 1011003 (Bicycle) 4 b
p 1011004 (Bicycle) | 4 a1

The Production Order View shows production orders categorized by status, the categories being
indicated by different colors depending on the selected view color mode, workfree periods
appearing slightly lighter.

5.2.1. Sorting

Production orders, their production order lines, and production order routing lines are sorted in
ascending numerical order.
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Within each production order, the relating production order lines with their production order
routing lines are listed.

This sorting order can be changed in the according dialog which can be opened either by context
menu or in the “Configuration”s tab of the user setup.

Edit - Define Configuration e

X

S0 Search  + New E% Edit List li] Delete A Move Up ¥ Move Down EH Open in Excel

Machine Center

Table Name Field Name Ascending Descendi...

— Machine Center |Nam4 O

5.2.2. Information shown on bars

The following information can be gathered from optical indicators:

e Currently marked operation:

i'lil

e Operation changed but not saved yet

e Vijolated due date
-['iﬂ‘l 007 i
5.2.3. Links

Links are shown after having clicked the desired production order or production order line as
described below:

e between operations of one production order line
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e between production order lines (make-to order)

¥ 20000 *

.m —. ‘

You can decide whether to show these links or not by ticking/unticking the according option
in the “General” section of the “Setup” dialog.

General
Pregidd Calsuliten Baded en Tists ¥ Shere Links Esptmaten Prod. Gk Licsd :_.l
Sheze Partial Frod, Croler Lisss "
4 101010 (Front Hub) Lg Al ¢
4 10000 ¥ ¢
10 (Drilling Machine)

40 (Drilling Machine) G\\

5 (CNC Machine)

50 (Assembly department)

20 (CNC Machine) ‘\
i \
30 (Machine Deburr) g— )
\
A
\

60 (CNC Machine)

4 101020 (Front Wheel)

4 10000 B 4

10 (Assembly department) E]
i

e between production orders

5.2.4. Sequence violation

The sequence of operations in BC is determined by routings (and reservations). If a production order
is created or recalculated, the operations are arranged according to these specifications. In the
planning board, these operations can be moved in relation to each other, thus perhaps causing
sequence violations.

The VPS now draws attention to these "not allowed" overlaps by symbols at the concerned elements
and in the table part, where the information is "passed up" to the parents to indicate the overlap
even in collapsed state or when the element is scrolled out of view.

boyumﬂ paGe 14 oF 62
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Visual Production Scheduler:  All ~ NETRONIC VPS Actions Fewer options
l| December 2023 { January 2024
Production Order | w52
fl 28 | 29
1] —
4 30000 ;
10 (Rim assembly) l =
Al & —
20 (Assembly department) =
30 (Deburm) o K

40 (Machine Inspection)

0]
50 (Wheel assembly) .\

L U T S

The meaning of the symbols in detail:

The element has a sequence violation. Shown at the bar or in the table. Can be
A displayed in the production order view at the production order routing line, in the
capacity view at machine/workcenter.

Al A child element has a sequence violation. Shown in the table header and both in the
production order view for production order lines/production orders or in the capacity
view for work center groups and work centers.
Sequence violations in the element itself and in child elements. In case of the work
Al center, there may be, for example, a sequence violation of a production order routing
line of the work center and a sequence violation of one of its machine centers.

The feature gets activated/deactivated in the "Scheduling" area of the "Setup" dialog:

Scheduling

Autoschedule With Zero Buffer Time

Predecessors

Successors

Schedule Across Prod. Order Lines

Conflict Handling of Reservations

Consider Queue Time

Consider Send Ahead Quantity

00880

|R0u1ing Sequence Violation Check

5.2.5. Due date

The due date of a production order is represented by a diamond-shaped symbol, turning red in case
of an exceeded due date.
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5.2.6. Progress

Based on the settings you have specified in the "Setup" dialog, you can display a progress bar for
production order routing lines of released production orders, the color of the progress bar
depending on the routing status and the percentage of completion. What’s more, finished
operations get grayed out:

e Status “finished”:

4 A

n u

e Status “none”, “planned”, “in progress”:

o Progress by quantity / by time < 100%: grey

o Progress by quantity / by time (i.e., you have posted more than initially planned) >
100%: red

5.2.7. Quickly see and create additional BC information

In Business Central, the planner can add additional information to a production order routing line/an
operation by creating comments, tool information, personnel information, and quality measure
information that are used, e.g., for describing certain specialties that need to be followed during the
production process. As this is, of course, valuable information, the VPS helps the planner to quickly
recognize whether a production order line/an operation has such additional information so that the
special requirements are not overlooked. You can also display this information in the tooltip.
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o

Prod. Order Routing Line
Operation No.: 10
<@ent Yes
Starting Date-Time: 01/25/24 10:04 AM
Ending Date-Time: 01/25/24 03:06 PM
Status: Firm Plannad
Prod. Crder Mo.: 1010005
Previous Operation Mo.:
MNext Cperation MNo.: 20
Production Order Line Line No.: 10000
Production Order Line ltem No.. 1000
Production Order Line Description: Bicycle
- Input Quantity: 16

H Schedule Status: MNone

Show Infosymbol on Additional Information

Show Symbol on Comment

Show Symbol on Tool Information

Show Symbol on Personnel Information

Show Symbol on Qlty Meas. Information

Shortcut to creating additional information

To activate the feature, tick the according option in the "General" settings of the VPS setup dialog:

You can directly create and edit additional information by clicking the according item in the context

menu.

Show Operation in Capacity View

Schedule Predecessors

b Schedule Successors

M Restore to Initial Values

Sort Order

Show Additional Information i Comments

Tool Information

Personnel Information

P Quality Measure Information

Edit - Prod. Order Rtng Qlty Meas.

O Search  —+ New B Edit List il Delet

029 Frame 1900 10

EE Open in Excel

Qlty Measure Code Description

—= VIS-INS : ‘V\sual ipspection needed

boyumli
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5.3. The Capacity View

Visual Production Scheduler:  All -~ | NETRONIC VPS ~~ Open in Excel Actions Fewer options

1l Ebmar}t 2021
Capacities k 05

il

4 Machining
il Shows/hides the capacity curve
4 Cutting
o Cutting #1 FI1@ 1 & @ 1@

i | | 0

L
e i @

e Shows capacity loads of work centers and machine centers, grouped by work center groups.

e Capacity bottlenecks and conflicts concerning delivery dates can be visualized by a red box in
the capacity curve and by according symbols in the table part.

e The bars are displayed in the colors depending on the selected color view mode, workfree
periods appearing slightliy lighter.

The meaning of the symbols in detail:

o M No overload at the parent resource (group) but at one or more subordinate
resource(s)

o il Overload at the resource (group) itself and at one or more subordinate
resources

o # Overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan, the symbol column will not be
shown.

5.3.1. Information shown on bars

The following information can be gathered from optical indicators:

e  Currently marked operation:

10

e QOperation changed but not saved yet

| I—
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e \Violated due date

5.3.2. Links

Links between operations are shown after having clicked one operation of the according production
order.

5.3.3. Sequence violation

The sequence of operations in BC is determined by routings (and reservations). If a production order
is created or recalculated, the operations are arranged according to these specifications. In the
planning board, these operations can be moved in relation to each other, thus perhaps causing
sequence violations.

The VPS now draws attention to these "not allowed" overlaps by symbols at the concerned elements
and in the table part, where the information is "passed up" to the parents in order to indicate the
overlap even in collapsed state or when the element is scrolled out of view.

Visual Production Scheduler:  All -~ NETRONIC VPS Actions Fewer options

! December 2023 January 2024

Capacities | Wk 52 Wk 01
§28 |29 {01

o Inventory department i i

4 4 Assembly department » [‘0 f
(10

o g

Mike Seamans »

The meaning of the symbols in detail:
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The element has a sequence violation. Shown at the bar or in the table. Can be
A displayed in the production order view at the production order routing line, in the
capacity view at machine/workcenter.

f 1 A child element has a sequence violation. Shown in the table header and both in the
production order view for production order lines/production orders or in the capacity
view for work center groups and work centers.

i l Sequence violations in the element itself and in child elements. In case of the work
center, there may be, for example, a sequence violation of a production order routing
line of the work center and a sequence violation of one of its machine centers.

The feature gets activated/deactivated in the "Scheduling" area of the "Setup" dialog:

Scheduling

Autoschedule With Zero Buffer Time

Predecessors

Successors

S5chedule Across Prod. Order Lines

Conflict Handling of Reservations

Consider Queue Time

Consider Send Ahead CQuantity

GO0 :880

|R0u1ing Sequence Violation Check

5.3.4. Due date

If you click an operation, a vertical line in the color of the operation's status appears, indicating the
due date.

Due date 1011002 I

5.3.5. Setup times

A context menu enables to show or hide the setup times

boyumli
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I
L

101009
Shimy Setup Times

HiEie Setup Times

If “Show Setup Times” is selected, they are visualized as grey section at the beginning of the bar

"
L
I
L

fio1009

5.4. The Histogram View

A histogram offers visual decision support by showing impending capacity problems. In the
Histogram View, the histograms of the work centers and their respective machine centers are
displayed.

Overloads at a resource are indicated by a red box in the chart and according symbols in the table
part.

January 2021 February 2021

Histogram
Wk 03 Wk 05

il

4 Machining

il

4 Cutting

8 Cutting #1 '
E-_l
8 Cutting #2 '
| =

The meaning of the symbols in detail:

o &) No overload at the parent resource (group) but at one or more subordinate

resource(s)

o @l Overload at the resource (group) itself and at one or more
subordinate resources

e B Overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan the symbol column will not be
shown.
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6. The calendar

The grey and white area in the background of the views visualizes the work and non-work periods of
the respective work/machine center. They are derived from the respective shift calendars

B’iday,. 22, January 2021 Saturday, 23. January 2021 Sunday, 24, January Zw Monday, 25. January 2(]

Production Orders
02:10{ 06:00 | 12:00 | 18:00

4 101011 Bicycle
4 100040
10 Assembly station #1
20 Assembly station 22
30 Assembly station #3
40 Inspection Table #1

6.1. Show/hide non-working periods

Some planning situations require to focus on the working periods of a work or machine center only.

To show or hide non-working periods, click the "Calendar" item in the "Actions" menu and select the
desired option.

Actions v  Fewer options

General
3 Calendar 7 | ' Show Norr«working Periods
Timescale > X Hide Non-working Periods

1010

Administration >

After having selected "Hide non-working periods", you'll only see the non-working periods that are
unique to some work and machine centers.
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F Jan Q Jonn 37, 2021 Jan 28, 2001 Jans 29, 202 Feb 01, 2021 Feb 02, 2021 Fet 03 ,\:-.‘7: Tob O4 2021 Feb 05, 2027 Feb 08 2021 Feb 0, 2021 Fob 10, 2021 F
Capacities it !
Tom #1 C o0y [ |
MA 8T s o o ol oo AN
|
4 Painting »
Painiting Cabin » oo (b fiowooz | fii
101011 | o108
Palting Robot ’ (101010 (161003 03008
paton foios |
Onng Cabin ’ 00 670 oo . M.
(1010}
Painting inspection » i1 (ool totoc naig
(101008
4 Asserrbly & OA ,
b Assomisy » (L T LTI i
» caa » ficor 4 o] @ WM O |
g s fioioss |
i
6.2. Individual design of weekend colors and date line grids

boyumli

Some of our customers use a 24-hour working calendar and, as they told us, sometimes have
difficulties navigating and planning by day in the diagram area because the change between
the days and/or weekends and working periods are not clearly visible. This, in turn, forces the
planner to constantly look back and forth between the timescale and the plan. So we set to
work and implemented two new visual elements to create a better connection between
timescale and diagram area:

o vertical separation lines between individually selectable intervals
o anindividual background color and transparency degree for weekends

In the picture below, the date line grid mode is set to "Daily", the background color for the
weekend to a light green.

B\ursday, 28.| Friday, 29. January 2021 Saturday, 30. January 2021 Sunday, 31. JanOX@P021 Monday, 01. February 2021
Capacities
4 Machining
4 Cutting »
Cutting #1 3
Cutting #2 » J -
Cutting #3 » -
4 Drilling 3
Drilling #1 3 [is00]50 st
Drilling #2 » 100
4 Milling & Turning »
Milling #1 3 -
Milling =2 » e
Turning #1 »
i
Milling & Turning » 1900|50
4 Assembly 8 QC
) Assembly b .
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The according settings can be found in the "Appearance" area of the VPS setup dialog:

e Dateline Grid Mode

Dateline Grid Mode Auto A
Mone
Weskend Coloring
. Daily
Colorize Weekend Weekly
Weekend Color #DAEFAS

The "Auto" mode causes the grids to automatically adjust to the resolution of the time scale resulting
from zooming in or out.

o Weekend coloring

Weekend Coloring

Colorize Weekend ‘)

Weekend Color #DAEFAS (/w
I\-l\—ll"

If you want to color the weekends individually, you can activate this here.

o By clicking you open the Color Picker dialog where you can

= select the desired color
= adjust the transparency:

Color Picker | - 7 X

\/

| ¥DAEFAS

“ Cancel
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= reset the weekend color to default comfortably and at one click:

Color Picker \O 7 X

Manage >
[ -1

Actions > | W Reset Color to Default...

Fewer options

~
+ Show as menu I |

#DAEFA9

“ Cancel

o Bar colors: Select individual bar color schemes that ensure that the label texts are always
visible.

The options in detail:

Graded (default): nonworking times are displayed in a lighter shade of the main

color; in case there are assignments during non-working periods they are drawn

in the main color
2 0 N 2 0 0 O A
| |

I
|
10 [0 |
10 '
1

;=
A : i
c i |
B IU I'IU 10 i
(]
=
A

7. Open Microsoft Dynamics 365 Business Central dialogs

The VPS fully integrates with Microsoft Dynamics 365 Business Central. This means that by double-
clicking the according element (production order, production order line, production order routing
line, work center etc.) either in the table area or in the Gantt area, you'll directly switch to the
according Dynamics 365 Business Central dialogs where you can navigate and make changes as usual:

Double-clicking a production order routing line...

boyumli
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4 10000

]

10 (Wheel assembly)

...will call the according dialog:

Manage Process Order Show Attached Page More options
EDIT - FIRM PLANNED PROD. ORDER - 1010005 - BICYCLE I/'
General -
<
MNa. |‘IO‘IOOOS | Search Description ‘ BICYCLE |
Description |Bicyc|e | Quantity ‘ ‘16|
Description 2 | | Due Date ‘ 30.01.2021 |
Source Type | Item v Assigned User ID ‘ e |
Source No. |‘IOOO v | Last Date Modified
Lines Manage More options
UNIT OF
STARTING ENDING DATE- MEASURI
ITEM NO. DUE DATE DESCRIPTION DATE-TIME TIME QUANTITY  CODE
1000 -30.01.202‘] Bicycle 26.01.2021 10:04  29.01.2021 16:00 16 PCS
] »
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8. Collapsing and expanding

4 )
The VPS allows to view your data from different angles easily and quickly. The symbols inthe
table allow to collapse and expand production orders, work center groups, work and machine
centers, thus hiding details or rendering them visible.

Please note that the VPS autmatically saves the collapsed/expanded state of a view so that you can
start exactly with the status you saw when you left the view.

All order categories collapsed:

[ January 2021 February 2021

Activities

Wk 06 Wk 07

} Planned

» Firm Planned

After having expanded the “Planned” category with order 109001 and all its sub-operations:

Activities

Th,| Fr, Jan 29, 2021 Sa, Jan 30, 2021 Su, Jan 21, 2021
08:1 12:00 AM 12:00 PM 12:00 AM 12:00 PM 12:00 AM 12:00 PM

4 Planned

4 109001 (Bicycle)

1]

4 10000

> -

10 (Wheel assembly)

20 (Chain assembly)

30 (Final assembly)

40 (Control)

» Firm Planned
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9. Capacity information

In the VPS, you can show a capacity curve in the Capacity View, to see free and exceeded capacities,
a red box in the capacity curve and by according symbols in the table part indicating an overload.

The meaning of the symbols in detail:

e &l Nooverload at the parent resource (group) but at one or more subordinate
resource(s)

. Wl Overload at the resource (group) itself and at one or more subordinate resources
e &/ Overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan the symbol column will not be
shown.

Visual Production Scheduler:  All -~ | NETRONIC VPS ~ Open in Excel | Actions ~ Fewer options

il

Ebmaw 2021
Capacities k 05

il

4 Machining

il 4 Cutting @

Shows/hides the capacity curve

0 Cutting #1 3

FI@ ] & 0@ 18
- @] r

»
E i @

T

The capacity curve combines information on a resource's allocation and its availability. If, for
instance, a task's duration is 10 hours, the capacity curve of a resource with an availability of 8
hours/day shows an overload - if it is calculated per day.

In many cases, the planner regards a resource's availability by week or even by month. That is why
the VPS lets you select whether you do the capacity calculation either by second, day, week, or
month. The curve will aggregate the occupancy on the selected period.
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Open in Excel Actions~  Fewer options
] General >
: View Filter >
Calendar >
Timescale >

Capacity Aggregation > B By Second

View > By Day
—  Administration > W By Week ]
. B9 By Month

10. Navigation in the VPS

Navigating in the VRV largely comprises setting the time range for which parts of your plan are
shown, modifying the timescale solution and quickly scrolling to certain parts of your plan.

10.1. Setting the timeframe

The timeframe specifies the time range covered by the timescale, either fixed by absolute values or
relative to the workday. This is done in the “Setup” dialog, to be reached by clicking the “General”
item in the “Actions” ribbon.

e e
"

E EDIT - VISUAL PRODUCTIOM SCHEDULER SETUP - ADMIN :!7'
-

i Timeframe Type

E Starting/Ending Date Input Type Relative date ¥

b

-

¢ Timeframe

E ABSOLUTE VALUES RELATIVE WALUES

E Starting Date 12/31,2020 Starting Date -4W

E Ending Date 4/28/2021 Ending Date +3M
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10.2. Change the timescale resolution

For zooming in a certain area of your plan or to zoom out for a better overview, you can change the
timescale resolution either by

10.3.

scrolling the mouse wheel in the timescale area
or, more specifically, by the corresponding items of the “Actions” menu, based on the work
date as having been specified in the settings of Dynamics 365 Business Central.

Actions ~  Fewer options

General
Mo, 25. Jan 2021
b0 View Filter
Calendar
Timescale > | B Fitinto View
B Capacity Aggregation ¥ Scroll to Workdate | |
View Scale to

w Administration

Navigating

The VPS offers the following options for quickly navigating to certain positions in the diagram:

10.3.1. Scrolling

the common scrolling options by vertical and/or horizontal scrollbar

dragging the timescale either right or left

scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

Actions~  Fewer options

General >

View Filter >

Calendar >

Timescale > | A Fit into View -
View > CroN 10 Workgaie
Administration > Scale to >
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10.3.2. Navigate within one routing

F-'
Show Cperation in Capacity View

Schedule Predecessars Go to First Operation

Schedule Successars Go to Previous Operation

Restore to Initial Values Go to Next Operation

— Sort Order Go to Last Cperation

3o to Any Cperaticn 1
Show Additional Information ® L

This function allows you to navigate in your plan easily and quickly, especially if you have long
routings with lots of operations. It can be found in the "Navigation" entry of the context menu.

10.4. Fitinto view

Select this item from the “Timescale” item in the “Actions” menu to switch directly to the timescale
as defined in the “Setup” dialog.
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10.5. Adjust the width ratio between table and diagram

For adjusting the width ration between table and diagram, put the mouse cursor on the sash
between the two parts and drag the double arrow appearing then.

Th, Jan 28, 2021 Fr, Jan 29, 2021

Production Orders

01:14 AM 12:00 AM

4 109001 (Bicycle)

1]

4 10000

10.6. Show operation in other view

Show the currently marked operation in the respective other view while it gets highlighted by a
blinking frame.

Show Operation in Capacity View

10.7. Search function
In both views, you can search for production order lines and operations.

The respective view automatically scrolls to the first search result - the operation (for production
order routing line) or the first operation of the production order line. The first found operation is
highlighted by a blinking frame and gets selected, so that the links are shown. If a view filter is active
the search dialog will only show the visible elements in the VPS.
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Actions ~~ Fewer options

General ?
View Filter 2 .
_ Search > % Search Production Order Line

_ Calendar > {# Search Operation

Timescale ?

Capacity Aggregation > Jr———
| View S . —
| Administration 2
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11. Move operations

You can move operations by mouse either horizontally or vertically, each way having a different
impact.

11.1. Move operations horizontally by drag & drop

To schedule an operation, you can move it horizontally along the time scale in the Production Order
View as in the Capacity View: As a consequence, the operation will be worked off at a different time.

26/01/2021 15:36,00

& 2021 7 5:35:59
FA01/2021 ° 5:35:5

11.2. Assign an operation to another resource

In the Capacities View, an operation can also be moved vertically when scheduled — to a different
work or machine center. As a consequence, the operation will be worked off by the work or machine
center it was moved to. While moving the operation, a “phantom” bar will remain at the original
place until the mouse will be released.

Mike Seamans » 105 =
|

(1011002
oo |
N orions |

Bryan Walton b |[1011004 | @N—-@

» PR oo

[1011003 |
[1011001 |

4 Packing department »
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11.3. Schedule predecessors/successors

If moving an operation shall also affect its linked preceding and/or succeeding operations to the
effect that they are moved accordingly you can make the according setting in the context menu.

Show Setup Times

Hide Setup Times

I

40 Show Cperation in Production Crder View

Schedule Predecessors

Schedule Successars

i

Restore to Initial Values

Please note that if you want these links to be taken into account for scheduling, you have to tick the
“Schedule across Production Order Lines” option in the "Scheduling" section of the “Setup” dialog.

Scheduling

AUTDSCHEDULE WITH ZERO BUFFER TIME

Predecessors

Successors

0|8 0

Schedule Across Prod. Order Lines

11.4. Move multiple selected operations

The VPS allows to select and move several operations in one go. This is done either by clicking them
while pressing the Ctrl key or by drawing a frame around the desired operations (rubber rectangle).
The feature needs to be switched on in the VPS settings with the following options:

e no multiple selection (default)

e select production order routing lines that are assigned to one capacity only
e multiple selection at will
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General

Progress Calculation
Show Partial Prod. Or...

Show Links between P...

Scheduling

‘ Based on Quantity

-
)

Startup View | Last Active View v
Show Symbol on Com... @
Selection Type Single v

Multiple on single Capacity
Multiple

Selected operations can be moved horizontally and vertically, the behavior of their predecessors and
successors depending on the settings in the VPS "Setup".

11.4.1. Moving with predecessors and successors

e First, the selected operations get moved. After having been placed at their target position,
the position of their possible predecessors and successors gets calculated.

e The target capacity is determined by the operation packed with the mouse:

Horizontal movement: other elements selected on other capacities will also be

moved horizontally only

o Vertical movement to a different capacity: the other operations are also moved to
this capacity

o

Capacities
1 1 02 |o4 |os
Fl
pwasiswes 0| @ @ @ IF0 FEMF B CMI1F
| eliee 1 | I |
[ &
—
4 Finishing | Endbearbeitung
4 Assembly | Montage »
Assembly | Montage #1  » EI '30 E: I ' . E@
o —
[ N
Assembly | Montage #2 b o N CI.:.
Aot Mo 12 > I —
Assembly | Montage #4  » || 130 [0 | Bl g 1 f
4 QC| QK »
aclakss g | [ | i PP B> 1
( [ [ |
|
1
|
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11.4.2. Handling of the progress status of an operation

e "Finished": the operations get selected, but will not be moved
e InProgress": as before, the user can decide per upcoming dialog which operation should be
moved or not

Capacities Wk 06 Wk 07
03 |04 |05 08 |09 |10 |1 |12 [#3]94 15 |16
! 4 Machining | Fertigung
} » Drilling | Bohren [20 (2' [10 H [20%0[20 rzi:.fo ﬁ ﬂ @ a @
T o o 2] E  @mN
el
} } Milling & Turning | Frasen 0 30 ;Ej s ﬁ”3o 0 r30 .EI .:.
- or WNIF om @ f i & Pl
(H O [ | E B33 | l
i rEER 1
(|
" Somgl s cun | @ @ mem el T " «
|
Doweargismin 0| 5] | B8 elel @@ 1 8 eaflE 1l
1 & a i G| —
| . ] [ ] ;
10 [20 I
l 4 Finishing | Endbearbeitung
1 4 Assembly | Montage
| Assembly | Montage #1 £ @ 50 |20 (60 ‘ @I [30 EI
] t |
,,,,, A mm W B . " | oA AT E
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11.4.3. Handling of reservations

Provided you have activated the "Conflict Handling of Reservations in the VPS "Setup" dialog, you'll
get a warning message if one of the selected operations violates the reservation, and the complete
moving process will be rejected.

There are one or more reservation conflict(s). The positioning of
all selected and scheduled operation(s) will be canceled.
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11.4.4. Show links

In analogy to the behavior of when single operations are moved, links to other elements are also
shown when multiple selected operations are moved.

11.4.5. Direct parallel routing

No parallel routing is carried out for multiple selected operations

i
I

i

]
4

Due Date 107

11.4.6. Due date line in the capacity view

|

,=|:_I

e In case the operations get selected by clicking, a due date line will be shown for the first

clicked element only
e In case of multiple selection via the rubber rectangle, no due dates will be shown

boyumli
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, .
" b” 24.H Th, 25. Feb 2021 | Fr, 26. Feb 2021
Capacities
1221 |00:00 |1200 |00:00 |12:00
» Milling & Turning | Frasen [ 0

Sa, 27. Feb 2021

Mo, 01. M;n‘\

Su, 28. Feb 2021

Tu, 02. Mar 2021 We, 03. Mar 2021

00:00

"

}

p Sawing | Sigen »

| » Welding | SchweiBen »

}

4 Finishing | Endbearbeitung

b Assembly | Montage » 'SO -

}

» QC|QK » (70 -

4 Subcontracting | Fremdferti I

12. Consider the queue time in the scheduling algorithm

The VPS allows to consider the queue time that is set on the machine/work center card in 365 BC.

Scheduling

Unit of Meéasure Code MINUTES Shop Calendar Code 1 L
Capacity 3 Cuewe Time 120
Efficiency 100 Queue Time Unit of Meas. ... IMINUTEQ o I
Consolidated Calendar ':.::l

Setting a queue time has no impact on the load of a work/machine center but causes the starting
time of the operation to be moved forward. It can be seen as a buffer time between an operation

and its successor so that you create a gap between the end time and the start time of two
consecutive operations:

The option can be activated in the VPS setup dialog:

boyumli
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EDIT - VISUAL PRODUCTION SCHEDULER SETUP - ADMIN I/

AUTOSCHEDULE WITH ZERO EUFFER TIME

Predecessors @]
Successors &
Schedule Across Prod. Order Lines @
Conflict Handling of Reservations Decide v
Consider Queue Time [ @]
Consider Send Ahead Quantity &

13. Consider the send-ahead quantity

In Business Central, the user can specify a send-ahead quantity for an operation when defining a
routing. The send-ahead quantity can be used to start a dependent operation before the current
operation is fully completed,

The VPS algorithm tries to avoid any gaps of nonproductive periods on the successor of an operation.
By that, the following operation may start later than expected, but therefore has a continuous
workload. This reduces the overall runtime of the production order line because the operations then
start to overlap. The successor does not have to wait until the predecessor finishes and hence has no
idle time.

The option can be activated in the VPS setup dialog:
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EDIT - VISUAL PRODUCTION SCHEDULER SETUP - ADMIN I/'

AUTOSCHEDULE WITH ZERO BUFFER TIME

Predecessors o
Successors &
Schedule Across Prod. Order Lines 'E'
Conflict Handling of Reservations Decide v
Consider Queue Time a
Consider Send Ahead Quantity a

14. Restore to initial values

In case you have made changes to one or more operations, not yet saved your plan, and want to
restore the original values again, click the according context menu item.

p——

[° -
Show Setup Times

l Hide Setup Times

]Pm Show Cperation in Production Crder View

ﬂ . Scheduls Predecessars

[[ l Scheduls Successors
r‘lﬂ Restore to Initial Values
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15. The “Setup” dialog

; The “Setup” dialog allows to customize basic settings
N Setup of the Visual Production Scheduler. You reach it via
“Actions” -> “Administration”.

Here you can make or see the basic settings for:

15.1. Editing Mode

Choose whether to work in the Scheduler Mode (default) or in the Viewer Mode which only allows to
view the plan but not change it.

Editing Mode

Editing Mode |\/ \\\\\ g Only ~v ‘

Scheduling

Viewing Only

Timeframe Type

Depending on the selected mode, the settings offered in the “Automatic Screen Updates” area of the
Setup dialog differ.

15.2. Timeframe:

Specify the timeframe that sets the time range covered by the timescale, either fixed by
absolute values or relative to the workday (see also .6.1, “Setting the timeframe).

Timeframe Type

Starting/Ending Date Input Type Relative date A
Timeframe

Absolute Values Relative Values

Starting Date 31.12.2020 Starting Date ‘—SD ‘
Ending Date 28.04.2021 Ending Date ‘ +6W ‘

15.3. General

e Choose whether to display a progress bar for production order routing lines of released
production orders, based on quantity or time.

General

Pragress Calculation | Based on Quantity

None

Based on Quantity
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e When, by setting filters, a single operation of a PO line gets filtered out, the standard
procedure in the VPS is to only visualize the complete PO line. By unticking the option,
you can switch to visualizing also a partial PO line.

General
Progress Calculation | Based on Time v
Show Partial Prod. Order Lines @

e Show links between production order lines: You can decide whether you want
dependencies to be illustrated by links in production orders with more than one
production order lines or not. Tick or untick the according option.

General
Progress Calcul... | Based on Time V| | Show Links bet... -) |
Show Partial Pr... @ Startup View | Last Active View V|

e Decide which view is shown upon starting the VPS. No matter which view you select, the
following settings get saved upon closing the VPS and are active the next time it gets
started:

o Show/hide setup times
o Show/hide work free periods
o Histogram aggregation

General
Progress Calcul... | Based on Quantity v Show Links bet... &
Show Partial Pr... [ @) Startup View Last Active View v

Last Active View

Prod. Order View
Capacity View

e Show Symbol on Comment: Decide, whether the VPS shall alert you to existing BC
comments by showing an info symbol on the production order line/an operation.

General
Progress Calculation ‘ Based on Time v Startup View | Last Active View v
Show Partial Prod. Or... @ Show Symbol on Com... - @D

Show Links between P... @

e Selection Type: Specify, whether and how the multiple selection of operations by CTRL +
clicking or by rubber band shall be possible or not.
o no multiple selection (default)
o select production order routing lines that are assigned to one capacity only
o multiple selection at will
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15.4.

boyumli

General
Progress Calculation | Based on Quantity A Startup View | Last Active View A
Show Partial Prod. Or... aa Show Symbol on Com... @
Show Links between P... @ Selection Type Single v
Multiple on single Capacity
i Multiple
Schedulina

Determine whether or not predecessor operations should automatically be re-scheduled
when an operation is modified.

Determine whether or not successor operations should automatically be re-scheduled
when an operation is modified.

Determine whether dependencies between several production order lines of a
manufacturing order are to be taken into account for the automatic planning.

Users can decide how they want to handle conflicts between existing reservation entries
and drag and drop actions they make in the planning board.

Warn and Reject: The message informs about the conflict, and then the drag & drop
action is rejected. That way, the users cannot violate any existing reservation with the
VPS.

Decide: The user receives a message about the conflict and can decide whether to cancel
or confirm the interaction. If the action gets confirmed, the conflicting reservation will be
removed.

None: No warning is giving about possible conflicting interactions and the conflicting
reservation will be removed.

Consider queue time: Decide whether the queue time specified in Business Central on
the work/machine center card is to be considered for the scheduling process.

Consider send-ahead time: Decide whether the send-ahead time specified in Business
Central on the work/machine center card is to be considered for the scheduling process.

Scheduling

AUTOSCHEDULE WITH ZERO BUFFER TIME

Predecessors

Successors

Schedule Across Prod. Order Lines

J80

Conflict Handling of Reservations Warn and Reject
Warn and Reject
Consider Queue Time Decida

Mone

Consider Send Ahead Quantity
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15.5. Filter

e You can determine whether the "Data filter" dialog comes up on starting the VPS or not.
Please note that if you decide to not have it shown, the last selected data filter will be
activated.

o The last selected view filter can be applied when the VPS is started.

Filter

Show Data Fitte.. - @ ) Enable Last Use.. - @ )
Data Filter

Current Data Fil... Freigegeben Machine Center...

Work Center Gr... Production Ord...

Work Center Fil..

15.5.1. Data Filter

e See which data filters are currently active. VPS - options automatic screen updates in
scheduling mode

15.5.2. Automatic Screen Updates

Depending on the selected mode, the settings offered in this area differ.
Scheduling Mode

Having selected “Scheduling” as editing mode, you can choose in this area whether the
current date-timeline is shown and how often it will be updated.

Automatic Screen Updates

Current Date-Time Line

w Current Date-Time Line a

Sho

Set Interval of Current Date-Time Line in Seconds ‘

Viewing Only Mode
In the “Viewing Only” mode you can specify
e whether and how often the view should be updated

e whether and how often the view should scroll
e whether the current date-timeline is shown and how often it should be updated
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Automatic Screen Updates

Reload of Data Horizontal Scrolling of Diagram
Enable Automatic Reload of Data [ o] Enable Horizontal Auto Scrolling of Diagram - - (D)
Set Interval of Automatic Reload of Data in ... ‘ 1 ‘ Set Interval of Horizontal Auto Scrolling of ... ‘ 1
Current Date-Time Line
Show Current Date-Time Line [ o]
Set Interval of Current Date-Time Line in Se... ‘ 1
15.6. Appearance
Appearance
ZFoom Factor(%6) ‘ 100‘ Selection Color ‘#ffaDClO ‘
Layout ‘ STANDARD o ‘ Tooltip Delay (ms) ‘ 2[]0{”

e Specify a zoom factor in percent.

e Choose a layout: In the "Compact" layout, the display is reduced as much as possible to
provide a better overview, especially with large plans.

e Standard layout:

Production Order

4 101033 (1 Operation Simple Subco Ppr—

10 (Subcontracting)

4 Firm Planned

4 101023 (1 Operation Simple Subco pr—
|
|

10 (Subcontracting)

4 101033 (3 Operations Subcontracir '

4 10000 4

10 (Cutting #1) m
20 (Subcontractor 1) fo1033j0 | | ||
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Compact layout:

Visual Production Scheduler:  All - | NETRONIC VPS ~ Open in Excel Actions Fewer options

Production Order

4 101033 (1 Operation Simple Subce

|

Il -

4 10000

10 (Subcontracting)

4 Firm Planned
4 101023 (1 Operation Simple Subco

4 10000

10 (Subcontracting) 101023 |0

4 101033 (3 Operations Subcontracir 4 . |

> >

4 10000 F
10 (Cutting #1) m

20 (Subcontractor 1)

30 (Inspection Table #1)

p 101034 (3 Operations Subcontracir F

|
) 101035 (3 Operations Subcon‘lra:] p— ¢
—

» 101036 (3 Operations Subcontra

b AN4AAE [Cramal I I A

Choose a selection color

Specify a tooltip delay: give a time in milliseconds after which the tooltip shall appear
Show/hide vertical separation lines between individually selectable intervals and select a
display mode:

Dateline Grid Mode Auto hd
None
Weekend Coloring
_ Daily
Colorize Weekend Weekly

Weekend Color #DAEFA9

The "Auto" mode causes the grids to automatically adjust to the resolution of the time scale

resulting from zooming in or out. For more information, see chapter The calendar.

Show/hide a status bar with real-time information about the active editing mode, view
filters, and color mode.

» 101058 (Prod 11 - type 1) pr— ¢

» 101058 (Prod 12 - type 7a) Lo i . L]
» 101062 (Prod 15 - type 2¢)

{ CE— A Kl N »

Ediling Mode: Scheduling Active view filter: No view filter active Active color mode: Production Order Status View

Bar colors: Select individual bar color schemes that ensure that the label texts are always
visible.
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Hide Status Bar

Bar Coloring Mode

Weekend Coloring Solid

_ COnly Allocated Times
Colorize Weekend 7

For more information on the options, see the Bar colors section in chapter "The Calendar".

e Specify the coloring mode of the weekends
e select whether you want to color the weekends individually

Weekend Coloring
Colorize Weekend [ o]
Weekend Color #DAEFA9

e click "..." to open the Color Picker dialog where you can
e select the desired color
e adjust the transparency:

Color Picker 7 X

#DAEFAS

KN -

e reset the weekend color to default comfortably and at one click:

Color Picker @ X

Manage

[
Actions > Y Reset Color to Default...

"
Fewer options
v Show as menu |

#DAEFA9

“ caned

boyumli
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16. Use filters

The VPS offers two kinds of filters, the difference between them lying in the time of application and
the data being used.

16.1. Data filters

Data filters work as Dynamics 365 BC filter on reading the data (either when the VPS is started or on
reloading) so that they are already effective at the data interface to make sure that only filtered data
are handed over from Dynamics 365 BC to the VPS.

16.1.1. Create and edit data filters

First, you have to open the according dialog by clicking "Choose Data Filter" in the "Setup" dialog:

Mew Actions Fewer options

Filter ~~

!F Choose Data Filter...

e B

In the dialog, you can edit, create and apply not only one but multiple data filters.

O Search  New E# Edit List [ Delete Show Attached [x:} Open in Excel Actions Fewer options
VPS FILTER CHOOSER /‘
NAME OWNER GROUP FILTERTYPE SUBCATEGORY
S ADMIN Individual User View
|Plan ned ) Company Wide Data
|ReTeased orders ADMIN Individual User View

To create a data filter, click “+New” and then enter the name of the new filter. To specify the filter
settings, click “Actions” “Edit Data Filter”.

O Search MNew B EditLlist [ Delete  Show Attached 8 Open in Excel
Yo edit Filter ) % Clear Filter
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You can filter by work center groups, work centers, machine centers and production orders:

EDIT - VPS FILTER IZ'
Work Center Group
Show results:
Where: | Code v is: | ~ |
And: | Name v is: | |

Work Center

Show results:
Where: | No. v s | v |
And: | Name v s | |
Machine Center
Show results:
Where: | No. v s | v |
And: | Name v is: | |
Production Order
Show results:
Where: | Status v | Released r
And: | No. v s | v |
And: | Description v o | |

e

If you want to make sure that the "Edit Data Filter “dialog pops up when you start the VPS, tick the
according option in the "Setup" dialog:

Filter

Show Data Filter on Start @
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16.2. View filters

View filters are applied to data already having been loaded into the VPS. Accordingly, only the
capacity utilization by the visible activities are shown in the histograms. To work with the filters, the
"Actions" menu offers three according options:

Actions~  Fewer options

General >

View Filter > | ¥ Choose View Filter...
Calendar > |+ Enable View Filter
Timescale > Disable View Filter I
View >

Administration >

16.2.1. Create and edit view filters

Click “Choose View Filter” to open the list of existing filters where you can create, delete and edit
filters as described in the “Data filters” section.

If you want to make sure that the last used view filter will be applied when you start the VPS, tick the
according option in the "Setup" dialog:

Filter

Show Data Filter an Stan ® Emable Last Used View Filter on Stan )
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17. Configure tooltips

The tooltips of the VPS provide further information on the following items of your production
schedule:

e production orders

e production order lines
e operations

e work center groups

e work centers

e machine centers

e planned and firm planned operations
e released operations

You can specify which information is to be shown in the tooltip of the respective item in the "Tooltip"
dialog - to be reached by clicking "Configurations" in the “Actions” menu of the "Setup" dialog:

Actions Fewer options

Configurations ~~

P Tooltip...
n

~ #% Label...

N [ S| P =

In the dialog popping up, you select the item for which you want to customize the tooltip and then
either delete, edit or add fields and then click the “Edit” item from the “Actions” menu:

O Search | Open in Excel Actions Fewer options

VIEW - SELECTTOOLTIP

i
N
X

Description T

Production Order

Production Order Line

Planned and Firm Planned Operations
Released Operations

Work Center Group

Work Center

Machine Center
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The dialog “Edit — Define configuration” pops up.

O Search  —+ New B2 Edit List [i] Delete A Move Up ¥ Move Down x(:} Open in Excel

EDIT - DEFINE CONFIGURATION

i
it
N

Production Order

Table Name Field Name
Production Order Description
Production Order Status

Production Order No.

Production Order Source Type
Production Order Source Mo.
Production Order Routing No.
Production Order Starting Date-Time
Production Order Ending Date-Time

Close

Here you can:

e Add anew field:
either click +NEW or just click in the last row. You can select the desired Dynamics 365 BC
data by clicking “...” either for table and field name.

AVAILABLE VALUES /‘
Value T
= Production Order

Production Order Line

e Insert a new field:
Select the field above which you want to insert a new one and proceed as described above.
e Delete a field:

Click "=~ and select “Delete line”

=% New Line |
2% Delete Line

M Select More I
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18. Configure bar labels
You can decide which D365 BC information is to be shown as bar label.

Bar labels are shown on

e operations in the Production View
e operations in the Capacity View

In the picture below, the bar label shows the production order number and the operation number,
separated by “|”.

10 (Subcontracting) 101023 | 10

You can specify which information is to be shown on the bar label of the respective item in the
according dialog to be reached by clicking "Configurations" in the "Actions“ menu of the "Setup"
dialog:

Actions Fewer options

Configurations ~~

5 Tooltip...
n

~ #% Label...

N [ S| P =

In the "View - Select Label" dialog, select the item and/or view for which you want to customize the
bar label:

O Search s Open in Excel Actions Fewer options

VIEW - SELECT LABEL

i
N
X

Description T
Operation in Production View

Operation in Capacity View

Close
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The “Edit — Define Configuration” dialog pops up:

O Search - New B Edit List il Delete A Move Up ¥ Move Down [x:} Open in Excel

EDIT - DEFINE CONFIGURATION

i
v
Y

Operation in Production View

Table Name Field Name

Production Order Line Prod. Order No.
WPS Format Strings |

- |Produdion Order| e : timestamp

Close

Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

18.1. Formatting the labels

Separate the field contents by a line break, a blank or a “|” by selecting the according separator from
the “VPS Format Strings” table.

AVAILABLE VALUES

Value
MNew Line
Space

|

The separators can get enhanced by the function “Extendible bar text separator” that has to be
implemented by the partner. Please contact us for further information.

19. Configure table labels

You can decide which D365 BC information is to be shown as labels in the table for:

e Production orders

e Production order lines

e Production order routing lines
e Machine centers

e Work centers
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e Work center groups

The picture below shows the table label for a production order routing line, containing:

e the operation number
e ablank
e the description in brackets

10 (Assembly station #1)

19.1. How to proceed

For customizing the table label, proceed as follows:

e |n both extensions click "Configurations" in the "Actions" menu of the "User Setup" dialog:

Actions Fewer options

Configurations ~
P Tooltip...
|
' #% Label...

| %
#t Table...

e Inthe "View - select table text" dialog, select the item for which you want to customize the

table label which, in our case, would be "Production Order Routing Line":

O Search [x:} Openin Excel Actions

VIEW - SELECT TABLE TEXT

Description T
Production Order
Production Order Line

Production Order Routing Line

Machine Center
Work Center

Work Center Group

Fewer options

i
N
X

Close
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e The “Edit — Define Configuration” dialog pops up:

O Search  —+ New B# Edit List lii] Delete A Move Up W Move Down x:} Open in Excel

EDIT - DEFINE CONFIGURATION

Production Order Routing Line

Table Name Field Name

= Operation Operation No.

VPS Format Strings

Space
VPS Format Strings (
Operation Description
VPS Format Strings )

Close

Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

19.2. Formatting the labels

Separate the field contents by a blank, or by the separators shown below by selecting the according
character from the “VPS Format Strings” table.

AVAILABLE VALUES

Value

Space

boyumli
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20. Custom fields

In addition to the default fields available in tooltip, label and table text it is possible now to equip
custom fields with data to use them in tooltip, bar label and table text.

b-:ln-:l.a',-_. January 24,

Production Order |
DED0 PM

4 103001 Bicycle

4 10000 Production Order

Description: Bicycle

10 W Status: Planned
Ma.: 109001

20 CH source Type: Item
Source Mos 1000

30 Fiy Routing Mo 1000

40 o Starting Date-Time: 01/28/22 11:45 AM
Ending Date-Time: 01728722 04:00 PM
CustamField: CUSTOMFIELD INFO

Please find a detailed description in the related Knowledge Base articles:

How to add custom fields to the VPS
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21. Reload and save data

In case you wish to discard your changes after modifying the diagram (provided you didn’t save
them) you can simply reload the data of the diagram. The “General” items allow to reload the former

values or, alternatively, to store your modifications.

Actions~  Fewer options

General > | BB Reload

- View Filter > H save d
Calendar >

| Timescale >

Capacity Aggregation >

T View > |

—  Administration »

If there are unsaved changes in your plan when you click “Reload”, a dialog pops up where you can

decide whether to save these changes or discard them.

o Would you like to save changes in the production schedule?

s Mo
After having saved your changes, a confirmation message pops up:
o The production schedule has been saved successfully!

Ok
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The successful reload will be stated by another message box:

o The Data have been successfully reloaded

OK
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